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1. Einleitung In diesem Versuch beschäftigen Sie sich mit der Modellierung und Simulation von Robotern. Es soll der Stäubli-Roboter RX-60 sowie sein Arbeitsraum aus Veruch 2 erstellt und getestet werden. Die Modellierung des RX-60 soll mit Hilfe des kostenlosen Modellierungstools Blender erfolgen. Um diese Aufgabe bewältigen zu können soll zunächst der Umgang mit Blender erlernt werden. Dabei müssen die Navigation im 3d Fenster und der Aufbau der Benutzeroberfläche erlernt werden. Nach diesen ersten Schritten sollen zwei Teile der Roboterperipherie modelliert werden. Zunächst soll mittels Oberflächenmodellierung eine Palette erstellt werden und anschließend durch CSG (Constructive Solid Geometry) eine Mutter. Sind diese Schritte erledigt wird anschließend das Herzstück - der Roboter simuliert werden. Hierzu muss die Geometrie des Roboters zunächst importiert werden und mittels Game Engine von Blender die Achsen des Roboters bewegt werden. Hausaufgabe: Wie oben bereits erwähnt, ist das Ziel dieses Versuchs einen Roboter zu simulieren. Damit dies möglich ist, ist es notwendig mit der Kinematik von Robotern vertraut zu sein. Bevor Sie den Versuch beginnen, bearbeiten Sie daher die Hausaufgabe aus Abschnitt 3.2.1. Anmerkung 1: Da die Blender Oberfläche komplett in englischer Sprache gehalten ist, werden im folgenden Text diese Begriffe nicht übersetzt, um Verwirrungen zu vermeiden. Anmerkung 2: Da Blender ein weit verbreitetes und vor allem kostenloses Tool ist, existieren im Internet zahlreiche Hilfeseiten und Tutorials. Sollte zu irgendeinem Zeitpunkt das vorliegende Dokument zur Lösung einer Aufgabe nicht ausreichend sein, suchen Sie im Internet nach einer Antwort auf das spezielle Problem. Bitte notieren Sie sich alle Unklarheiten, so dass diese für nachfolgende Studierende eingearbeitet werden können. Anmerkung 3: Alle im Folgenden bearbeiteten Teilaufgaben müssen so gespeichert werden, dass sie beim Kolloquium präsentierbar sind.
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2. Die Blender Oberfläche Beim Starten von Blender fällt zunächst auf, dass sich neben dem Hauptfenster noch ein zweites, kleineres Fenster öffnet. Dieses Fenster darf nicht geschlossen werden, da ansonsten das komplette Programm ebenfalls geschlossen wird. Es muss jedoch auch zunächst nicht weiter beachtet werden. Das Fenster dient hauptsächlich als Konsolenausgabe. Einleitende Erklärung: Da viele Tastenkombinationen in Blender benutzt werden, ist es nötig, deren Gebrauch zu erklären. Um dies sinnvoll in den Text einzufügen werden in Zukunft Abkürzungen genutzt. Dabei beschreiben: • ’LMB’, ’MMB’, ’RMB’ die drei Maustasten (links, mitte, rechts), • ’MMBS’ bezeichnet das Mausrad, • NUM0 - NUM9 und NUM+, etc. die Tasten auf dem NumPad, • 0 - 9 die Zahlentasten im Hauptfeld der Tastatur, • A - Z die Buchstabentasten im Hauptfeld der Tatsatur, • Strg+Shift+P wäre eine Kombination, welche gleichzeitig gedrückt werden muss. Das Hauptfenster von Blender ist auf den ersten Blick in zwei Bereiche unterteilt. Im oberen Teil ist ein Gitter zu sehen mit einem Koordinatensystem und einem Quadrat. Im unteren Bereich sind einige Kästen mit verschiedenen Schaltflächen zu sehen. Das obere Fenster ist der ’3d View’, das untere wird ’Buttons Window’ genannt. Siehe Abbildung 2.1. Es ist immer das Fenster aktiv, über welchem sich Ihr Mauszeiger befindet. Fahren Sie mit dem Zeiger über die Fenster und achten Sie darauf, wie die Header der Fenster aufleuchten. Welches Fenster aktiv ist, ist wichtig für die spätere Bedienung. So können beispielsweise keine Tastatureingaben in einem inaktiven Fenster gemacht werden. Die Unterteilung der Fenster ist nicht fest und kann je nach Bedarf angepasst werden. Mit dem Mauszeiger kann die Grenze zwischen den Fenstern verschoben werden. Des Weiteren können weitere Unterteilungen der Fensterfläche eingefügt werden. Klicken Sie dazu mit RMB auf die Unterteilung zwischen den Fenstern. Wählen Sie ’Split Area’ und anschließend mit der Maus den Bereich, den Sie als neues Fenster abtrennen wollen. Um
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Abbildung 2.1.: Die Blender Oberfläche die Bereiche wieder zu vereinen, gehen Sie ähnlich vor, wählen Sie dieses mal jedoch ’Join Areas’ und wählen Sie das Fenster aus, welches entfernt werden soll. Siehe Abbildung 2.2. Die gesamte Benutzung des Programms ist darauf ausgelegt, dass eine Hand stets die Tastatur bedient und die andere die Maus. Dies sollten Sie, um effektiv zu arbeiten, möglichst oft beherzigen.



2.1. Das 3d Fenster Nun wenden wir uns dem ’3d View’ zu. Auf den ersten Blick sieht dieses Fenster lediglich zweidimensional aus. Halten Sie die MMB im 3d Fenster gedrückt und bewegen Sie die Maus. Sie können erkennen, dass das Quadrat tatsächlich ein Würfel ist. Weitere Navigationsmöglichkeiten bieten unter anderem die Aktionen aus Tabelle 2.1. Navigieren Sie mit diesen Befehlen im 3d Fenster, um sich an die Umgebung zu gewöhnen. Wenn Sie mit der Steuerung der Ansicht vertraut sind, fahren Sie fort mit den nächsten Punkten. Als sehr effektive Navigation hat sich die Bedienung allein durch MMB, MMBS und die Shift-Taste erwiesen. Dies entspricht dem Ansatz „One Hand on Mouse, One Hand
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Abbildung 2.2.: Vereinigung zweier Fenster



NUM1 NUM3 NUM7 Ctrl+NUM1 Ctrl+NUM3 Ctrl+NUM7 NUM2/NUM8 NUM4/NUM6 NUM5 MMB MMBS Shift+MMB NUM,



Frontview Sideview Topview Backview Sideview Bottomview RotX ±15◦ RotZ ±15◦ Orthographic/Perspective Projection Rotate Zoom Pan (Verschieben der Ansicht) Bei angewähltem Objekt setzen des Sichtzentrums Tabelle 2.1.: Navigation im 3d Fenster
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on Keyboard“. Beim Ändern der Sicht erscheinen noch zwei weitere Objekte. Zum einen eine Kamera und zum anderen eine Lampe. Diese Objekte werden fürs erste jedoch nicht beachtet. Um Objekte auszuwählen wird in Blender der RMB benutzt. Um den 3d Cursor zu setzen wird der LMB benutzt. Wählen Sie nacheinander Würfel, Lampe und Kamera aus und zentrieren Sie die Ansicht mittels NUM,. Wählen und zentrieren Sie wieder den Würfel. Versuchen Sie anschließend den Cursor direkt in der Kamera zu positionieren und überprüfen Sie durch Drehen der Ansicht, ob Sie Erfolg damit hatten. Um derartige Aufgaben in Zukunft schnell und sicher zu erfüllen bietet es sich an zwei orthogonale Ansichten zu nutzen. Zum Beispiel NUM1 und NUM3.



2.2. Das Werkzeugmenü Der zweite wichtige Teil der Bedienoberfläche ist das sogenannte ’Buttons Window’. Dieses befindet sich unterhalb des 3d Fensters und beinhaltet je nach Kontext verschiedenste Optionen. Die einzelnen Fenster innerhalb des ’Buttons Window’ können ebenfalls neu angeordnet und strukturiert werden. Damit die vorliegende Einführung gut genutzt werden kann, sollte von dieser Möglichkeit jedoch kein Gebrauch gemacht werden. Sollten zu irgendeiner Zeit die einzelnen Fenster nicht gut sichtbar sein kann mittels MMBS, Shift+MMBS und Ctrl+MMBS im ’Buttons Window’ navigiert werden.
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3. Geometrische Modellierung Um ein 3d Modell eines Körpers zu erstellen gibt es viele Möglichkeiten. Die im Zusammenhang mit diesem Praktikum wichtigen Methoden sind • Oberflächenmodellierung, • Constructive Solid Geometry. Anmerkung: Blender ist gnadenlos. Wenn Sie zu irgendeinem Zeitpunkt das Blenderoder das Konsolenfenster schließen, ist alles was Sie bis dahin erarbeitet haben weg. Unter Umständen funktioniert die ’restore last session’ Funktion. Wenn Sie Glück haben. Seien Sie also nie übereifrig beim Schließen irgendwelcher Fenster und speichern Sie stets Ihre Fortschritte ab.



3.1. Oberflächenmodellierung Bei der Oberflächenmodellierung wird ein vorhandenes 3d Netz (Mesh) (zum Beispiel ein Einheitswürfel) solange verändert, bis seine Geometrie der des zu modellierenden Objektes entspricht. Für diese Methode bietet Blender eine große Anzahl von Werkzeugen an.



3.1.1. Erstes Modell Das Erstellen des ersten Modells dient lediglich der Einarbeitung. Es soll die Navigation im 3d Fenster verinnerlicht werden und erste Modellierungsschritte veranschaulichen. Desweiteren sollen wichtige Werkzeuge kennengelernt werden. Das Ziel in dieser Teilaufgabe soll es sein, ein Kreuz zu modellieren. Abbildung 3.1 zeigt ein Beispiel dafür, wie das erste modellierte Kreuz aussehen könnte. Viele Befehle funktionieren in Blender ähnlich. Sie sollten daher auch die Bedienung einfacher Befehle gut verinnerlichen, um bei komplexeren Aufgaben leichteres Spiel zu
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Abbildung 3.1.: Beispiel eines detaillierten Kreuzes haben. Um etwas in dieser Art zu erhalten, gehen Sie wie folgt vor. Halten Sie sich jedoch nicht zu lange mit dieser Aufgabe auf. Sie dient nur dem Einstieg. 1. Wählen Sie den Würfel aus (RMB). 2. Mittels TAB wechseln Sie vom ’Object Mode’ in den ’Edit Mode’. In diesem Modus ist es möglich, das Objekt zu verändern. Im Edit Mode können Sie die einzelnen Flächen, Kanten und Ecken des Würfels erkennen. Die Flächen sollten nun lila, die Punkte und Kanten gelb angezeigt werden. Drücken Sie ’A’. Dadurch werden alle Punkte an- oder abgewählt. Gelb bedeutet angewählt, lila abgewählt. Durch RMB und Shift+RMB werden einzelne oder mehrere Punkte iterativ angewählt. Es ist ebenfalls möglich direkt Kanten oder Flächen auszuwählen. Dazu dienen die Schaltflächen am unteren Bildrand (siehe Abbildung 3.2). Die vierte dieser Schaltflächen dient dazu verdeckte Kanten anzuzeigen. Dies ist in vielen Situationen sehr hilfreich. 3. Wählen Sie die komplette obere Fläche aus. Dazu gibt es mehrere Möglichkeiten. Alle diese Möglichkeiten sind in verschiedenen Situationen wichtig, daher sollten Sie alle beherrschen. Einzelauswahl: RMB
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Zusatzauswahl: Shift+RMB Jedes Objekt wird zusätzlich ausgewählt. Blockauswahl: ’B’ drücken, mit LMB Kasten ziehen. Alles im Kasten wird zusätzlich ausgewählt. Kreisauswahl: Zwei mal ’B’ drücken. Der Cursor wird ein Kreis. Mit MMBS kann die Größe geändert werden. Alles unter dem Kreis wird bei LMB zusätzlich ausgewählt. 4. Extrudieren Sie die gewählte Fläche. Dazu gibt es erneut zwei Möglichkeiten. Die erste wäre, über das Menü zu gehen. Dieses erreichen Sie direkt über SPACE. Dann Edit -> Extrude ->Region. Die Option ’Region’ erscheint nur, wenn Sie nicht die Flächenauswahl aktiviert haben. Die zweite Möglichkeit wäre einfach ’E’ zu drücken, dann Region auszuwählen. Nahezu alle Funktionen, die in den Menüs sind, sind ebenfalls über Hotkeys zu finden. Wenn man diese beherrscht, spart man viel Zeit, Suchaufwand und Ärger beim Modellieren. Um die Richtung, in der Extrudiert wird, einzuschränken, drücken Sie ’X’, ’Y’ oder ’Z’. Je nach Auswahl wird die Operation auf diese Koordinate eingeschränkt. Im Anschluss können Sie durch Bewegen der Maus die Operation ausführen. Zusätzlich gedrücktes Shift verfeinert die Bewegung, Ctrl beschränkt die Bewegung auf das Raster. LMB akzeptiert die Änderung, RMB verwirft sie. Der Extrude Befehl ist dennoch ausgeführt worden. Es liegen dann also die extrudierten Punkte auf den ursprünglichen Punkten. Eine andere Möglichkeit den Ausschlag zu bestimmen ist die numerische Eingabe über die Zifferntasten. Bsp.: Auswahl -> E -> ENTER -> Z -> 1 -> ENTER. Das erste ENTER fällt weg, wenn Sie Flächenauswahl aktiviert haben. 5. Wiederholen Sie den vorigen Schritt, bis Sie durch insgesamt 4 ’Extrudes’ ein Kreuz erschaffen haben. 6. Wählen Sie die untere Fläche des Kreuzes aus, drücken Sie ’G’. Diese Operation (Grab) ermöglicht das Verschieben von Vertices (Ecken). Verschieben Sie die untere Fläche entlang Z auf die gewünschte Länge. 7. Wählen Sie die anderen drei äußeren Flächen aus. Drücken Sie ’S’. Hiermit werden alle Vertices skaliert. Wählen Sie eine beliebige Skalierung. 8. Um das Ergebnis zu verfeinern, drücken Sie ’K’, wählen Sie ’Loop Cut’. Wenn Sie anschließend über Ihr Objekt fahren, erscheinen lila Schnittmuster. Mit MMBS kann die Anzahl der Schnitte bestimmt werden. Fügen Sie an einigen Stellen Schnitte ein und verfeinern Sie so ihr Mesh. 9. Skalieren, verschieben oder extrudieren Sie die neuen Flächen, Kanten oder Ecken, um ein Gefühl für diese Funktionen zu bekommen.
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Abbildung 3.2.: Auswahlmodus Knöpfe 10. Um ein Kreuzteil abzurunden können Sie eine Funktion aus dem Buttonsfenster nutzen. Drücken Sie im Fenster ’Modifiers’ auf ’Add Modifier’ und wählen Sie ’Subsurf’. Hierdurch wird die Oberfläche komplett unterteilt. Alles wird rund. Es gibt eine einstellbare Stufe. Auf keinen Fall sollte man hier übertreiben. Ein Wert größer als 3 ist selten sinnvoll. Drücken Sie vorerst nicht auf ’Apply’, um die Modellierung einfacher zu halten. Um Kanten, die kantig bleiben sollten zu erhalten gibt es die ’Crease’ Funktion (Shift+E). Der Crease-Wert einer Kante gibt deren „Eckigkeit“ an und kann Werte zwischen −1 und 1 annehmen. Testen Sie diese Funktion an Ihrem Kreuz. Beachten Sie, dass weiterhin das kantige Grundgerüst vorhanden ist und so einfach bearbeitet werden kann. 11. Wenn Sie mit dem Ergebnis zufrieden sind, wechseln Sie in den ’Object Mode’, drücken Sie ’Apply’ um die Veränderung am tatsächlichen Mesh zu übernehmen und wechseln Sie zurück in den ’Edit Mode’ um das neue Mesh zu begutachten. TAB A B SPACE E G S X, Y, Z K Shift+E



Wechsel zwischen Object und Edit Mode Auswahl alles/nichts Auswahltool Box/Kreis Menü Extrude Grab Scale Einschränkung auf Koordinatenachsen Knife (Loop Cut) Crease Edge [−1..1] Tabelle 3.1.: Neu gelernte Befehle 1



3.1.2. Palette In dieser Teilaufgabe soll es darum gehen, eine Palette zu modellieren. Diese Palette dient dazu Muttern aufzunehmen. Abbildung 3.3 zeigt die Maße. Desweiteren kann das Original am Praktikumsroboter eingesehen werden. Diese Aufgabe setzt nun voraus, tatsächliche Maße anzugeben. Um dies zu tun bietet
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Abbildung 3.3.: Maße der Palette sich das ’Transform Properties’ Fenster an. Dieses kann mittels ’N’ geöffnet werden. Über dieses Fenster können auch Eigenschaften verändert werden. So können beispielsweise im ’Edit Mode’ direkt Vertex-Koordinaten angegeben werden. Die Maßeinheit, die Blender verwendet, ist konsistent aber beliebig (in Zukunft Blender-Maß-Einheit, BME genannt). Eine Maßeinheit kann also mm, m oder auch Zoll sein. Für die folgenden Versuche hat sich allerdings gezeigt, dass die Wahl 1BM E = 1m zu klein ist. Besser geeignet sind 1BM E = 1dm oder 1BM E = 1cm. Wählen Sie für sich eine passende und halten Sie sich daran, damit es nicht zu Skalierungsproblemen kommt. Unter Umständen müssen Sie, wenn Ihre Einheit zu klein ist, die Clippinggrenzen von Blender einstellen. Die in der vorangegangenen Aufgabe erlernten Funktionen reichen aus, um diese Aufgabe zu erfüllen. Ein möglicher, grober Ablaufplan wäre: 1. Neue Session starten. 2. Den Standardwürfel in die Bodenebene verwandeln durch Verschiebung der Eckpunkte. 3. Durch ’Loop Cuts’ genügend Unterteilungen in der xy-Ebene erzeugen. 4. Die 12 Stifte durch ’Extrudes’ erzeugen.
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5. Die Stifte durch den ’Subsurf Modifier’ abrunden. 6. Durch ’Creases’ echte Kanten erhalten. 7. Modifier anwenden. Um das Ergebnis anschließend realistischer erscheinen zu lassen, können mittels ’Bevel’ Funktion Kanten abgerundet werden. Diese Funktion findet man im Specials Menü. Dieses Menü erreicht man durch ’W’. Nützlich hierbei ist die Loop Selection, die durch Alt+RMB komplette Kantenzüge auswählt. Shift+Alt+RMB erweitert diese Auswahl entsprechend. Bevels haben einen Zahlenwert größer Null, welcher deren Größe beschreibt. Dieser wird per Maus oder durch Zifferntasten eingestellt. N Alt+ RMB W



Transform Properties Fenster Loop Selection Specials Menü



Tabelle 3.2.: Neu gelernte Befehle 2 Wenn Sie fertig sind, speichern Sie Ihr Ergebnis. Abbildung 3.4 zeigt, wie Ihre Palette ungefähr aussehen sollte.



Abbildung 3.4.: Die fertige Palette.



3.1.3. Mutter Nachdem Sie nun die Oberflächenmodellierung von Objekten beherrschen, soll nun ein alternatives Verfahren erlernt werden. Es ist möglich, ein räumliches Objekt als Kombination von Standardprimitiven zu definieren. Diese können beispielsweise Würfel, Kugeln oder Zylinder sein. Ein neues Objekt entsteht durch den Schnitt, die Vereinigung oder
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die Subtraktion zweier Teilobjekte. Folgender rekursiv definierter regulärer Ausdruck beschreibt das Konstruieren mit Raumprimitiven (CSG=constructive solid geometry). • < Objekt >::=< P rimitive > | < Objekt >< T ransf ormation > ARGU M EN T | < Objekt >< Operation >< Objekt > • < P rimitive > ::= QU ADER|KEGEL|ZY LIN DER|KU GEL|... • < T ransf ormation >::= T RAN SLAT ION |ROT AT ION |SKALIERU N G • < Operation > ::= V EREIN IGU N G|SCHN IT T |DIF F EREN Z Jedes Objekt ist als binärer Konstruktionsbaum darstellbar. Die Blätter repräsentieren die Primitivkörper, die Knoten enthalten die Operationen und Transformationen der Objekte.



Abbildung 3.5.: Beispielobjekt Abbildung 3.5 zeigt ein beispielhaftes Objekt. Dieses Objekt kann in einem Baum durch einen Zylinder, einen Quader und eine Kugel dargestellt werden. Die Kugel wird längs der z-Achse verschoben und vom Zylinder abgezogen. Das resultierende Objekt wird um die x-Achse gedreht und längs der y-Achse verschoben. Dann wird dieses Objekt von dem Würfel subtrahiert. Somit erhält man den Würfel mit der runden Aussparung. In den Blättern des Baumes stehen die Primitive oder die Parameter der Transformationen. In den Knoten sind die Mengenoperationen und die Typen der Transformationen angegeben. Abbildung 3.6 zeigt den zugehörigen Graphen.
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Abbildung 3.6.: Graph des Beispielobjekts Beim Modellieren mit Standardprimitiven werden die Operationen als regulär vorausgesetzt, d.h. man geht davon aus, dass das Ergebnis einer Operation entweder ein neues dreidimensionales Objekt ist, oder die leere Menge ( wenn zwei Objekte keine gemeinsamen Punkte haben, ist die Schnittmenge leer). Als Ergebnis kommt aber nie ein Kantenzug oder eine einzelne Ecke heraus. Die Darstellung der Objektkonstruktion durch einen binären Konstruktionsbaum, ist nicht eindeutig. Aus dem Beispiel ist leicht zu ersehen, dass die Translation und die Rotation des ersten resultierenden Objektes getauscht werden können, wir erhalten dennoch ein äquivalentes Endprodukt. Ein solcher Baum kann auch die leere Menge repräsentieren, dies wäre in unserem Beispiel unter der Voraussetzung möglich, dass der Quader zu klein ist. Zögen wir den Zylinder mit Kugelaussparung dann von dem Quader ab, erhielten wir die leere Menge. Mit dieser Methode soll nun die Mutter aus Versuch 2 modelliert werden. Stellen Sie hierzu zunächst einen CSG-Baum auf. Anschließend soll dieser Baum mittels Blender verwirklicht werden. Abbildung 3.7 zeigt hierzu die Maße der Mutter. Die Funktionalitäten für CSG-Modellierung finden sich im Object Mode. Primitivkörper werden mittels SPACE -> Add Mesh erzeugt. Die Operationen finden Sie durch SPACE -> Object -> Boolean Operation, oder direkt ’W’. Durch diese Operation wird ein neues Objekt als Ergebnis erzeugt. Verschieben Sie im Anschluss die Ursprungsobjekte und überprüfen Sie das Ergebnis. Wenn alles stimmt, können Sie die Ursprungsobjekte löschen oder unbeachtet lassen. Beachten Sie weiterhin, dass neu erstellte Objekte im aktuellen Cursor erstellt werden. Des Weiteren können Sie Ihre Orientierung von der Ansicht erben. Es ist also sinnvoll alle Objekte aus dem Top View zu erstellen. Funktionen um den Cursor zu setzen bietet Shift+S. Da Blender ein Oberflächenmodellierungstool ist, sind die CSG
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Abbildung 3.7.: Maße der Mutter Funktionen nicht komplett verlässlich. Untersuchen Sie daher, nachdem Sie fertig sind, Ihr entstandenes Mesh. Sollten überschüssige Vertices vorhanden sein, entfernen Sie diese mittels ’X’ oder DEL. Sollten Löcher in Ihrem Mesh entstanden sein, können Sie diese füllen. Wählen Sie dazu die Kantenvertices aus und Drücken Sie ’Shift+F’. Sollte dies nicht funktionieren, beschränken Sie die Auswahl auf lediglich drei Vertices und drücken Sie ’F’. W Shift+S X F Shift+F



Boolean Operations Snap (Cursor Optionen) Löschen Kante/Fläche erzeugen Fill



Tabelle 3.3.: Neu gelernte Befehle 3 Abbildung 3.8 zeigt das Modell der fertigen Mutter. Speichern Sie Ihr Modell in eine neue Datei.



3.2. Der RX-60 An dieser Stelle sind nun sowohl die Palette, als auch die Mutter modelliert. Es fehlt also nur noch das Herzstück, der Roboter. Da die Geometrie des RX-60 zu komplex ist, muss diese an dieser Stelle nicht modelliert werden. In Ihrem Praktikumsordner finden Sie eine Datei mit Namen ’RX60.blend’. Diese Datei enthält die Geometrie des Roboters als Dreiecksnetz. Öffnen Sie diese Blender-Session. Die Maße des echten Roboters sind in
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Abbildung 3.8.: Fertige Mutter.



Abbildung 3.9.: Skalierungsüberprüfung des Roboters Abbildung 3.10. Um die Maße konsistent zu halten muss nun die Skalierung des Roboters überprüft werden. Gehen Sie dazu in den Edit Mode und betrachten Sie die Z-Koordinate eines beliebigen Flansch-Punktes. Zur Erinnerung: ’N’ öffnet das Eigenschaftsfenster, siehe Abbildung 3.9. Die tatsächliche Höhe beträgt 1006mm. Skalieren Sie nun den Roboter passend zu Ihrer Wahl. Beachten Sie dabei, dass das ’Transform Properties’ Fenster sowohl lokale, als auch Globale Koordinaten anzeigt. Die nötige Skalierung müsste in jedem Fall einen Wert 10x haben.
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Abbildung 3.10.: Der Stäubli RX-60
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3.2.1. Die Kinematik ! Um die Roboterkinematik gut zu verstehen ist es nötig, dass Sie mit den DenavitHartenberg Parametern vertraut sind. Vertiefen Sie zu Hause deren Theorie und stellen Sie die Parameter des RX-60 auf. Nehmen Sie dazu Abbildung 3.10 zur Hilfe. Die Parameter werden vor Beginn des Versuchs vom HiWi kontrolliert. ! Im initialen Zustand besteht der gesamte Roboter aus einzelnen Gliedern. Betrachten Sie sich die Glieder und deren Meshes. ’H’ versteckt ausgewählte Vertices, ’Shift+H’ alle nicht ausgewählten und ’Alt+H’ macht alle Vertices wieder sichtbar. Insgesamt gibt es sieben Glieder von der Basis bis zum Flansch. Im nächsten Schritt werden sich die Glieder bezüglich ihrer Koordinatensysteme bewegt. Wenn diese nicht korrekt liegen, kommt es zu unerwünschten Bewegungen. Kontrollieren Sie die Koordinatensysteme der Objekte und vergewissern Sie sich, dass diese auf den Drehachsen liegen. Überprüfen Sie die Zentrierung, indem Sie das Objekt um die Drehachse drehen. Sieht die Drehung falsch aus, müssen Sie den Vorgang wiederholen. Wenn alles korrekt aussieht, wechseln Sie in den Object Mode und betrachten Sie die Koordinaten der einzelnen Glieder im Transform Properties Fenster. Vergleichen Sie diese mit Abbildung 3.10. Finden Sie Parallelen? Welche? Die Modellierung ist an dieser Stelle abgeschlossen. P H Shift+H Alt+H



Objekt erstellen aus Auswahl Verstecke Auswahl Verstecke nicht Ausgewähltes Zeige alles



Tabelle 3.4.: Neu gelernte Befehle 4
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4. Simulation In diesem Kapitel gilt es nun, dem Modell des Roboters Leben einzuhauchen. Hierfür wird die Game Engine von Blender benutzt.



4.1. Gelenke Zunächst müssen jedoch Abhängigkeiten festgelegt werden. Dies ist nötig, damit sich Glied 7 bewegt, wenn sich Glied 6 bewegt und so weiter. Hierzu wählen sie erst das höhere und dann mit Shift+RMB das tiefere Glied aus und drücken Sie Ctrl+P->Make Parent. Überprüfen Sie die Einstellung indem Sie das tiefere Glied verschieben. Das Höhere muss sich nun mitverschieben. Desweiteren muss eine schwarze, gestrichelte Verbindungslinie sichtbar sein. Selektieren Sie nun das erste bewegliche Glied, also nicht die Basis. Wählen Sie im ’Buttons Window’ ’Logic’ aus, siehe Abbildung 4.1. Dies ist der Logik-Editor, in dem Bewegungsbefehle generiert werden können. Um eine Bewegung zu definieren, müssen Sensoren, Controller und Aktuator hinzugefügt werden. Generieren Sie per ’Add’ jeweils einen Sensor, Controller und Aktuator, siehe Abbildung 4.2. Verbinden Sie die kleinen Punkte miteinander. Nun muss der Sensor definiert werden. Wählen Sie als Typ Keyboard und suchen Sie sich eine Taste, welche das erste Gelenk positiv rotieren soll, zum Beispiel Q. Definieren Sie anschließend den Aktuator indem Sie eine kleine Rotation um Z angeben, zum Beispiel 0.02. Wiederholen Sie diesen Vorgang für die negative Rotation. Das Ergebnis sollte in etwa aussehen, wie Abbildung 4.3. Drücken Sie nun ’P’, um die Simulation zu starten und testen Sie Ihre Steuerung. Wenn alles funktioniert, wiederholen Sie den Schritt für alle fünf anderen Gelenke.



Abbildung 4.1.: Game Engine im Menü
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Abbildung 4.2.: Hinzufügen von Controllern



Abbildung 4.3.: Fertige Steuerung für Gelenk 1 Jetzt sollten Sie in der Lage sein den gesamten Roboter zu bewegen.



4.2. Greifer Wenn der Roboter voll beweglich ist, muss ein Greifer hinzugefügt werden. Wechseln Sie wieder in den Editing Kontext. Wählen Sie eine passende Ansicht und generieren Sie den Greifer aus 3 Einzelteilen, der Basis, linkem Finger und rechtem Finger. Alle diese Objekte müssen Kinder des Letzten Roboterglieds sein. Anschließend fügen Sie eine Taste zum Greifer Öffnen und eine zum Greifer Schließen ein.



4.3. Zusammenfügen der Roboterzelle Wenn nun alles funktioniert, fügen Sie alle Einzelteile zusammen in eine Zelle. Mit Shift+D können Sie Objekte, also in diesem Fall die Mutter, duplizieren. Um ein Objekt in die aktuelle Scene zu laden, wählen Sie: File -> Append Or Link und suchen Sie in dem jeweiligen .blend file nach Object. Klicken Sie dies an und wählen Sie das Mesh aus (also weder Lamp noch Camera). Ist das Objekt nicht veränderbar, duplizieren Sie es und löschen Sie das Original. Platzieren Sie alle Komponenten nach Ihrem Belieben.



23



Abbildung 4.4.: Auswahl Rigid Body



Abbildung 4.5.: Fertige Roboterzelle Wählen Sie die Mutter aus, gehen Sie in den Logic Kontext und wählen Sie oben links ’Rigid Body’ (siehe Abbildung 4.4. Die Muttern gehorchen nun einer simplen Physik. Wenn Sie mit dem Roboter gegen Sie fahren werden Sie weggestoßen. Damit die Muttern nun nicht ins Bodenlose fallen, generieren Sie eine Bodenebene. Mit dieser Aufgabe ist der Versuch abgeschlossen. Versuchen Sie eine Mutter zu Greifen und Sie abzulegen. Da das Modell jedoch noch sehr einfach gehalten ist, ist diese Aufgabe recht schwierig zu bewältigen. Ctrl+P Shift+D



Make Parent Objekt duplizieren



Tabelle 4.1.: Neu gelernte Befehle 5
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A. Hotkeys NUM1 NUM3 NUM7 Ctrl+NUM1 Ctrl+NUM3 Ctrl+NUM7 NUM2/NUM8 NUM4/NUM6 NUM5 MMBS Shift+MMB NUM,



Frontview Sideview Topview Backview Sideview Bottomview RotX ±15◦ RotZ ±15◦ Orthographic/Perspective Projection Zoom Pan (Verschieben der Ansicht) Bei angewähltem Objekt setzen des Sichtzentrums



Tabelle A.1.: Hotkey Sammlung Navigation
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TAB A B SPACE E G S X, Y, Z K Shift+E N Alt+ RMB W W Shift+S X F Shift+F P H Shift+H Alt+H Ctrl+P Shift+D



Wechsel zwischen Object und Edit Mode Auswahl alles/nichts Auswahltool Box/Kreis Menü Extrude Grab Scale Einschränkung auf Koordinatenachsen Knife (Loop Cut) Crease Edge [−1..1] Transform Properties Fenster Loop Selection Specials Menü Boolean Operations Snap (Cursor Optionen) Löschen Kante/Fläche erzeugen Fill Objekt erstellen aus Auswahl Verstecke Auswahl Verstecke nicht Ausgewähltes Zeige alles Make Parent Objekt duplizieren



Tabelle A.2.: Hotkey Sammlung Editing
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